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Register in LOGIN.GOV
• Create Account Using Government Email 

Address

• Select Language (English, Spanish, French)

• Send Request

• Respond to Sent Email to Confirm Email 
Address

• Create Password

• Setup Authentication - Government Employee 
ID (CAC)

• Sign-in with Your Government Employee 
ID(CAC)



FPDS via LOGIN.GOV
• Now you can Login to FPDS using 

LOGIN.GOV

• Do not Enter Email Address and Password

• Scroll and Click - Sign in with Government 
Employee ID

• Click - Insert your PIV/CAC

• Select the Certificate Shown and Click -
OK

• Email Address in Login.gov Matches 
FPDS User IDs with Same Email Address 
– Select User ID (if more than one)



Register in LOGIN.GOV
If CAC Email Changes - i.e. @mail.mil to @army.mil

• May Need to Delete Login.gov with Old Email

• Register Again in Login.gov with New CAC Email

• Adding a Second Email to Login.gov May Work Temporarily

• Safer to Delete Old Email and Register with New Email



SAM.gov Background
• FPDS Reports Are in SAM Databank (since 3/16/2020)

• Static Reports

• Standard Reports

• Administrative Reports (must request admin user role)

• Ad Hoc Reports 

• ezSearch remains in FPDS for now

• No User Roles Required to Run Most Reports

• Contract Data Admin Role
• Needed for Administrative Reports and FAADC Access



SAM.gov Background
• Direct Web Access - https://sam.gov

• FPDS database is Not Connected to SAM Reports

• FAADC database is Not Connected to SAM Reports

• Daily FPDS Add/Correct/Deletes Sent to SAM

• Daily FAADC Add/Correct/Deletes Sent to SAM

• Must Refresh SAM database with Current data
• Usually Completed by 9:00 AM ET

https://sam.gov/


SAM.gov Background - Data Refresh
WARNING - SAM Data Refresh May 
Process Longer

• ALWAYS Check SYSTEM ALERTS Prior 
to Executing a Report or Getting Output 
from a Scheduled Report

• When Data REFRESH IS NOT 
COMPLETE

• Report Results Will Have Numbers 
Too High or Too Low

• DO NOT USE REPORTS

• Scheduled Reports Will Also Be 
Inaccurate

Click – SEE ALL ALERTS – SYSTEM ALERTS (upper 

right)



Data Refresh - System Alerts
• Turn On ACTIVE and EXPIRED Alerts

• Scroll through Recent Alerts – Look for:



SAM.gov Background

• If SAM.gov is not Working Properly
• Keeps Returning to the Login Screen

• System Could be Down – Wait and Try Later

• Problems Keep Repeating 
• Go in Browser to Get to Settings

• In Chrome Go to Privacy and Security

• Clear Browsing Data  - All History for All Time 



Four DATA BANK Report Types
• Sign in to SAM.gov

• Land on WORKSPACE with 
Your Profile

• Click - DATA BANK

• Click - CONTRACT DATA

• Click – Radio Button under 
Report Types

• Static

• Standard and/or 
Administrative (needs admin user role)

• Ad Hoc Reports



Standard Reports - Data Bank, Contract Data
FPDS Standard Reports

• Predetermined Additional Filter Criteria for Reports 

• Same Filters and Run on the Same Day = Same Results

• Drill Down to Display Additional Field Columns

• SORT GRID to Sort on Multiple Fields

• Execute Report to Run on a Schedule (Daily, Weekly)

• Export Results to Desktop as EXCEL, CSV, HTML, Text File

• Print Results by Exporting PDF to Desktop and Print

• Email Results through SAM.gov to non-SAM users



Standard Reports - Data Bank, Contract Data
• Sign in to SAM.gov

• Land on WORKSPACE with Your Profile

• Click - DATA BANK

• Click - CONTRACT DATA

• Click – Radio Button for STANDARD 
REPORTS

• Scroll to the 37 Standard Report Names

• 10 Report Names per Page – Four Pages 
of Report Names

• Click on Report Name to Open Criteria and 
Execute



Standard Report – Report Criteria
• Date Range From and To Dates

• Corresponds to Date Signed on Procurement 
Awards

• Organization
• Defaults to Your SAM.gov User Profile (gray 

background)

• Click - X at End of Your Organization to Remove It

• Results in All Federal Government Data for Date 
Range

• Covers Dept Code, Agency Code, Command 
Code and Office Code

• Contracting Office Region – non-DOD Field



Standard Report Criteria - Organization
• Organization

• Can Enter a Maximum of 20 values

• 4 Types of Organization Codes
• Department Code - i.e. 9700 = DOD; 4700 = GSA; 7000 = DHS

• Agency Code - i.e. 5700 = AF; 2100 = Army; 97AE = DARPA

• Command Code - i.e. AMC, NGB, NAVSEA, AFMC

• Office Code - i.e. FA8609, W31P4Q, N00019, SPE300

• Realize How 20 Values Are Evaluated

• Use Same Org Code Type or Use 2 – 4 Org Code 
Types



Standard Report Criteria - Organization
• Organization Example

• Enter 9700; 4700 (Department Codes)

• Enter 97AE; 2100 (Agency Code)

• Enter NGB; NAVAIR (Command Codes)

• Enter FA8609; N00019 (Office Codes)

• Asking For DOD and GSA, then DARPA and Army

• Asking For NGB and NAVAIR and 2 DODAACS



Standard Report Criteria - Organization
• Go to the Lowest Level DODAAC

• DODAAC must equal FA8609 or N00019

AND

• Command must be NAVAIR or NGB

• FAIL – NO DATA for FA8609 is not in NAVAIR or NGB

AND

• Agency Code Must be Army(2100) or DARPA(97AE)

• FAIL – NO DATA for N00019 is not in Army or DARPA



Standard Report Criteria - Organization
AND

• Department Code must be DOD or GSA

• We Never got to Department Level Evaluation

• Two Conclusions

• ONE - Enter All Values at Only One Level
• Enter only Dept Codes and No Other Data Level

• Enter only Agency Codes and No Other Data Level

• Enter only Command Codes and No Other Data Level

• Enter only Office Codes and No Other Data Level



Standard Report Criteria - Organization
• TWO - Lowest Level Entered Must Match One Value 

At Every Higher Level Entered

• Example:

((DODAC = Value1 OR Value2)

AND (COMMAND = Value1 OR Value2)

AND (AGENCY = Value1 OR Value2)

AND (DEPARTMENT = Value1 OR VALUE2))

• N00019, NAVAIR, 1700, 9700 - All 4 Values Must Be Present in 
Organization to get Results for N00019



Standard Report Criteria - Organization
GOOD DATA Combination Examples:

• DODAAC - N00019, W31P4Q, FA8609, 

• Command - AMC, AFMC, NGB, NAVAIR, NAVSEA

• Agency - 1700, 2100, 5700 , 97AE, 97AS

• Department - 4700, 7000, 9700

• N00019 -> NAVAIR -> 1700 -> 9700 - Good Combo

• FA8609 -> AFMC -> 5700 -> 9700 - Good Combo

• W31P4Q -> AMC -> 2100 -> 9700 – Good Combo



Standard Report Criteria - Organization

• NO DATA from

• Command – NAVSEA (No NAVSEA DODAAC)

• Agency - 97AE, 97AS (No DODAACs for DARPA or DLA)

• Department – 4700, 7000 (No Office Code in GSA, DHS)



Commands for Standard Report 
After Execution 1. Go Back

2. Display Data Grid

3. Create Graph or graph with 
Data

4. Email Report

5. Schedule Report to Run 
Automatically

6. Export Report to EXCEL, 
CSV, txt File

7. Export Report to PDF

8. Refresh Data



Standard Reports - Data Output
Drill to Reveal More Fields

1. Right Click Column 

Heading

2. Mouse Over DRILL

3. Select One Field to 

Appear Next in 

Report

4. Repeat for Additional 

Fields to Appear



Standard Reports - Drilling

• Mouse Position is Critical Before Right Mouse Click
• Drill from a Column Header and All Data in Report Stays

• Drill from a Data Row - Only Data For the Row Stays

• 15 Additional Fields Can Be Added in Drill Process
• Limited to 150,000 Rows of Data Output 

• Exceed 150,000 Rows - There is No Warning of Lost Data
• Make Sure Adding a Field Will Not Lose Data

• Last Drill Feature - Award Detail (150,000 Row Limit)
• Get All Records with the Majority of Fields Behind Report



Standard Reports – Drilling Limitations

Can Drill to Award Detail 
When < 150,000 Rows

Cannot Drill to Award 

Detail with 1,795,692 

Rows



Static Reports - Data Bank, Contract Data
Static Reports

• Current National Interest Reports are Run Daily

• Official Standard Reports ‘Frozen’ in Time

• Small Business Goaling Reports by Fiscal Year

• Top 100 Contractor Reports by Fiscal Year by Agency

• Procurement Reports by FY, Agency, Geographic Location

• Most are PDF format Created as Official for A Fiscal Year



Administrative - Data Bank, Contract Data

Administrative Reports

• SAM User Needs 
Contracts Admin 
Role to Run Report

• Must Ask Existing 
Admin User to Assign 
Role to You

4 Administrative 
Reports Run in Real 

Time

• Audit Procedures -
Uses Live Data

• FPDS Contracting 
Office - Uses Live 
Data

• List of FPDS Users -
Uses Live Data

• Status of Actions –
Uses Live Data

4 Administrative 
Reports Updated Once 

per Day

• Individual Data Item 
Oversight Tracker

• Rerepresentation

• Rerepresentation 
Eligible Actions

• Transfer Action



Ad Hoc Reports - Data Bank, Contract Data
• Custom Report - Your Filters and Your Field Selection

• Save Report for Future Execution

• Share Report Code with Other SAM.gov Users

• Data Summarization Occurs when All Field Values Shown Have 
Same Value for Multiple Records

• Must Know Fields and Relationship Between Fields

• Must Test Report Results for Accuracy

• You Are Your own Programmer - Check Your Work



Ad Hoc Reports – Data Bank, Contract Data
• Sign in to SAM.gov

• Land on WORKSPACE with Your Profile

• Click DATA BANK

• Click CONTRACT DATA

• Click Report Type - Ad Hoc

• Choose 1 of 3 Databases to Access

• Award/IDV Information Report - FPDS

• Financial Assistance Award Data Collection 
(FAADC) Report - FAADC

• Other Transaction Information Report – OT’s



Ad Hoc Reports – Data Bank, Contract Data
Ad Hoc – My Reports Page

1. Database Selected

2. Your Saved Reports

• Double Click on Name 

to Run Report 

• Right Click on Name 

For  Additional Menu 

Options

3. Change Sort Order Click 

on Any Column

4. Click Create to Start New 

Report



Ad Hoc Reports – New Report

1. Click - CREATE (red)

2. Click - NEW REPORT

3. Click - BLANK REPORT

Recommend not Using Report Builder 
• Too Restrictive



Ad Hoc Reports – New Report
1. Enter Start and End Dates for Date Signed

• Use One Recent FY to Create Draft 
Report

• Maximum 12 Years for a Start/End Date 
Range

2. No Dates Needed for Last Modified Date 
Range

3. Go to Bottom Left Corner; Click - Edit in 
Design Mode

Enter Report Name Here



Ad Hoc Reports – Design Mode (or edit)
Design Mode - Four Screen Areas

1. ALL OBJECTS - All Fields Available to 
make a Report

2. REPORT FILTER – What Data is Selected 
for Report

• Initially Only the Date Signed Start/End 
Range is the Filter

• Without Adding A Filter, You Get All the 
Data for Date Range

3. OUTPUT GRID - 4 Boxes Are Field & 
Column Names

4. PAGE BY is an Advanced Feature - Do Not 
Use Initially



Ad Hoc Reports – Design Mode (or edit)
ALL OBJECTS Divided into 2 Groups – Public Objects  Metrics (all numeric 
Fields) Schema Objects  Attributes (all non-numeric Fields)

FPDS Tree Structure FAADC Tree Structure 



Ad Hoc Reports – Design Mode (or edit)
• FAADC Can Access 2 Different Data Types 

• Draft Records and Final Records

• At CREATE Step a Decision for Draft or Final is Made
• Along with Blank Report vs. Report Builder (never use)

• Select either Draft Blank Report or Final Blank Report

• Draft Report Cannot Change to See Final Data

• Final Report Cannot Change to See Draft Data

• A New Report Must Be Created to Switch Data Types



Draft vs. Final Records in FAADC

Ad Hoc Reports – Design Mode (or edit)



Ad Hoc Report - Design Mode(edit)
Design Mode Commands – Black Bar Command Icons

1. Run Report

2. Cancel Run

3. SAVE

4. SAVE AS (1st time)

5. Make Report Filter Disappear - DO NOT 

USE

6. Report is to Create a Data Grid

7. Report is to Create a Graph Or Graph With 

Data

8. Set Report SORT 



Ad Hoc Reports – New Report
• Click - CREATE (red)

• Click - NEW REPORT

• Click - BLANK REPORT
• Never Use Report Builder (Too Restrictive)

• Enter Start and End Dates for Date Signed
• Use One Recent FY to Create Start Drafting a Report

• Maximum 12 Years for a Start/End Date Range

• No Dates Needed for Last Modified Date Range
• Go to Bottom Left Corner; Click - Edit in Design Mode



Ad Hoc Reports – Design Mode (or edit)
• Start Moving Fields to the Output Grid

• Suggest - Do Metrics First - Schema Objects -> Metrics
• Must Select One Metric - suggest - Number of Actions

• Number of Actions Show If More Than One Record is Behind a Given 
Row in the Report (value is not One)

• Add from the Remaining Four Metrics, if needed.

• 3 Ways to Move Field from ALL OBJECTS to GRID
• Double Click on Field Name – adds field to the far right

• Right Click on Field Name and Choose ADD to GRID

• Left Click and Hold on Field Name and Drag into GRID



Ad Hoc Reports – Design Mode (or edit)
Left Click and Hold on Field Name and Drag into GRID

• Make sure Yellow Vertical Bar appears in the Grid



Ad Hoc Reports – Design Mode (or edit)
• Go Up All Objects Data Tree to Get to 

Attributes

• Top Box Click Down Arrow - Click - Award IDV 
Info

• Click -> Schema Objects -> Attributes

• Open Folder (18) Where Desired Field 
Resides

• Move Attribute Field from ALL OBJECTS to 
GRID

• Double Click on Field Name – adds field 
in front of Metrics

• Right Click on Field Name and Click -
ADD to GRID

• Left Click and Hold on Field Name and 
Drag into GRID



Ad Hoc Reports – Design Mode (or edit)
Get to Attributes by Going Up All Objects Data Tree

1

2

3 4



Ad Hoc Reports – Design Mode (or edit)

Attribute Folders

• 18 Folders

• Learn Field Location

• Attributes on Top Bar

• Search 2nd Bar
• Type Field Name

• Click - Search icon

• Move Field to Grid

Search

Business Size

Dates

Contract ID/Info

Who Awarded

Who Funded

Bundled, PSC, 

NAICS

Prepared, Approved, 

ClosedEntity Info

Click to expand folders



Ad Hoc Reports – Design Mode (or edit)
Search Attribute Folders for Field

1. First Bar  

• Ensure Attributes is selected

2. Second Bar

• Type Part of Field Name

• Click Magnifying Glass to run search 

3. Diamonds are attributes search results

4. Select to Move to GRID

• Double Click - Field Name 

• Right Click - ADD to GRID

• Left Click - Drag into GRID

Search



Ad Hoc Reports – Design Mode (or edit)
• Output Grid – DO SAVE or SAVE AS (first time)

• Start with small number of Fields for Draft Report

• Now Add Report Filter and Test If Filters Get Data

Output Grid – Fields 

and Column Headings

Report Filter –

Only Dates



Ad Hoc Reports – Design Mode (or edit)
• Go Up All Objects Data Tree to get to Attributes

• Top Box Click Down Arrow – Click - Award IDV Info

• Click -> Schema Objects -> Attributes

• Open Folder (18) Where Desired Field Resides

• Move Field from ALL OBJECTS to REPORT FILTER
• Right Click on Field Name and Click - ADD to Filter

• Left Click and Hold on Field Name and Drag to Report Filter

• Release with Yellow Line Box Around Report Filter



Ad Hoc Reports – Design Mode (or edit)
Left Click and Hold on Field Name 

and Drag to Filter
Or Right Click on Field Name 

and Click - ADD to Filter



Ad Hoc Reports – Design Mode (or edit)

REPORT FILTER

1. Click - Qualify

2. Select Operator

3. Type Data Value

4. Click - Apply



Ad Hoc Reports – Design Mode (or edit)
REPORT FILTER

Edit again – Click blue 

text

Cookie Crumbs to Return 
to different places

Filter Added



Ad Hoc Reports – Design Mode (or edit)
Report Filters - Qualify vs Select buttons

• Qualify

• Means You Know the Value in the Database 
and Can Type it Accurately (i.e. DODAAC 
for Office ID)

• Type a Wrong Value and No Records are 
Returned

• Select

• Is Needed When You Do Not Know the 
Database Values

• Select Shows You Every Value for the Field

• You Select the Correct Value(s) to Use.



Ad Hoc Reports – Design Mode (or edit)
Report Filter - Operators (20)

• 16 Operators Can Have Only One Data 
Value for the Field

• 4 Operators Allow More than One Value in a 
String

• BETWEEN/NOT BETWEEN-Upper and Lower Value 
Limits(2)

• IN/NOT IN – More than 1 Value Separated by 
Semicolon (;) 

• How Many Values Can Be In a String 
(v1;v2;v3;v4;v5;..;vN)?

• Tested 10,000 Office DODAACs and It Works

• Limit is a Software Buffer of approx. 8 kb 
(8,000 characters)

• Exceed Buffer Size and Get an Error
• Solution is to Use a Second Report Filter Using 

IN operator



Ad Hoc Reports – Design Mode (or edit)
Report Filters

• Multiple Filters Possible

• Each Are Joined with an AND

• Example:

Date Signed is between 10/01/2021 and 09/30/2022

AND Contracting Agency ID = 1700

AND Major Command Code in NAVSEA;NAVAIR;ONR;SSP

• NO SPACES are Allowed in the Data Value String

• Wrong Filter Combinations can Cause No Data Retrieved



Ad Hoc Reports – Design Mode (or edit)
SAVE AS – first time

• Save your work frequently

• Supply Report Name

• Document What Report is Doing in 
Description

• Click – OK

• Choose – Run Newly Saved Report

• Report Succeeds with a Data Grid of 
Values Requested

• Execution Phase Starts with More 
Capabilities to Change Report

Training Demo



Ad Hoc Report - Execution Mode(Data Output)
Black Bar Icon Commands (frequently used ones)

1. Toolbar Pull Down Menus

2. Save As

3. Design (edit)

4. Display Data grid

5. Create Graph Or Graph With Data

6. 25 Versions of Accounting Formatting of Grid

7. AUTOSIZE Columns Report Values

8. AUTOSIZE Columns to Screen Window



Ad Hoc Report - Execution Mode(Data Output)

REPORT 

HOME Pull 

Down Menu

• SAVE and SAVE AS

• DESIGN -Go back to Design Mode (edit)

• SHARE - Give code to Other User

• SEND NOW - email report output now

• SUBSCRIBE TO - Schedule Recurring Run

• EXPORT - EXCEL, CSV, TXT file, etc.

• PRINT - as a PDF



Ad Hoc Report - Execution Mode(Data Output)
TOOLS Pull Down Menu

Most are Advanced Features

• NEW 

• To Create a New Report

• REPORT OBJECTS 

• Display Only Fields in the 
Report

• ALL OBJECTS 

• Display All Fields Available 
for a Report

• PAGE BY AXIS (advanced –
leave off)

• PIVOT BUTTONS 

• Adds Buttons to Each 

Column Heading

• Move a Column to Be a 

Row

• SORT Buttons (want it on)

• Turns On/Off Column 

Heading Sort Arrow

• REPORT BAR (want it on)

• Turn On/Off Report Stats-

Num Pages/Rows



Ad Hoc Report - Execution Mode(Data Output)

DATA Pull Down Menu

• Sort - Goes to SORT GRID

• Drill -Same Drill Fields from Std. 
Reports

• Refresh - Rerun Report

• Re-Prompt - Prompt for Date 
Changes

• Insert New Metric 
(advanced)

• Rename - Change Column 
Headings Text

• Show Totals

• Click - SHOW TOTALS

• Each Field Gets a Total 

(probably do not want)

• Click – EDIT TOTALS

• ALL SUBTOTALS -

Uncheck box

• Using Subtotal is an 

Advanced Feature 

• Check - Grand Total Box –

to get Final Total

• Click – APPLY and OK 

Boxes



Ad Hoc Report - Execution Mode(Data Output)

• FORMAT (pull down - click down arrow)

• Advanced Formatting
• Change Entire Report Template

• Change Font and Style and Size

• Change Font Color

• Change Cell Padding and Lines

• Recommend to Take Format Defaults



Ad Hoc Report - Execution Mode(Data Output)

• FORMAT (pull down - click down arrow)

• RESIZE Columns and Rows

• Use for a Report Used Repetitively

• Worth the Effort to Size Columns of Similar Field Types
• Make All Long Description Fields – Same Size (i.e. 2.5 inches)

• Make All Dollar Fields – Same Size (i.e. 1 Inch)

• Under DATA use RENAME to rename Column Headings to 
Common Use Names in your organization (i.e. MSC vs 
MAJCOM vs MACOM vs Major Command Code)



Ad Hoc Reports – Check List
• Create -> New Report -> Blank Report -> Date Range

• Edit in Design -> Metrics to Grid -> Go Up All Object Tree

• Attributes to Grid -> A Few Fields, Same as Filters

• Attributes to Report Filter -> Save As -> Run Newly Saved

• Check Date Range -> Run Report -> Validate Results

• Add More Attributes to Output -> Report Home -> Save

• Format -> Resize Columns -> Data -> Rename Headings

• Report Home -> Save -> Data -> Re-prompt -> Run Report



Ad Hoc Reports – Check List
• Validate Results

• Report Home -> Export -> Formatted EXCEL to desktop

• Report Home -> Subscribe -> History List
• Set Run Immediately -> Daily 7:15 PM

• Advanced Options -> Uncheck Box to Overwrite Self

• Delivery -> Do Not Deliver After 12/31/2023

• Change Name at top to Be Descriptive Name

• i.e. - N00019 FY 22,23 PSC DAILY until 12/31/2023 - > OK




